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General Information
Introduction
This manual contains installation, operation and maintenance instructions for the Chandler
Engineering Model 3530 Viscometer.

Purpose and Use
The Chandler Engineering Model 3530 Viscometer is a fully automated concentric cylinder
viscometer designed to measure the rheological properties of test fluids by measuring shear
stress at specific shear rates. This viscometer is the standard instrument referred to in the
industry standards API Spec 10 (well cements), API RP 13B (drilling fluids) and API RP 39
(fracturing fluids).

Description
The Chandler Engineering Model 3530 Viscometer is an automated version of the versatile
Model 3500 and 3500LS instruments that have been used in research laboratories, field and
mobile labs, and onsite QC testing.
The viscometer can be equipped with a variety of bobs, rotors, and springs. This provides
the user with a wide measurement range in addition to providing different gap sizes
depending upon the fluid being tested. When operated manually, the 3530 has a low-end
RPM of 0.1, enabling a measurement at 0.17 sec-1 when equipped with the R1, B1
configuration. When operated via the Rheo 3000 PC Interface, rotor speeds as low as 0.01
RPM can be achieved.
The measurement fluid is contained within the annular space or shear gap between the rotor
and bob. The rotor is rotated at known velocities (shear rates) and the viscous drag exerted
by the test fluid creates torque on the bob. This torque is transmitted to a precision torsion
spring, and its deflection is measured and related to shear stress. The equations used to
calculate the fluid viscosity are presented later in the manual (Viscosity Calculations in
Section 2 – Operating Instructions).

Features and Benefits
•
•
•
•
•
•
•
•

CE certified.
Fully automated viscometer for control and data acquisition.
Easy to set-up, easy to operate, easy to clean and maintain.
Broad range of sensitivity/scalability through the use of different springs and
rotor/bob combinations to accommodate a wide variety of fluid types.
Use of a DC controlled motor allows the Model 3530 to be used in a 50Hz or 60Hz
environment while maintaining the proper RPM readings.
Manual preset speeds include 0.1, 0.2, 0.3, 0.6, 1, 2, 3, 6, 10, 20, 30, 60, 100, 200,
300 and 600 RPM. The Rheo3000 software can command any speed from 0.01 –
1000 RPM.
Precision machining of the rotor, the bob, and support pieces allow perfect alignment
each time the instrument is used.
Stainless steel sample cup comes scribed for 350ml sample size.
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Specifications
Operating Conditions:

41°F - 104°F (5°C - 40°C)

Voltage Rating:

100 – 240 VAC

Current Rating:

2 Amps

Frequency Rating:

50/60 Hz

Environmental:
Pollution Degree:
Installation:
Altitude:
Humidity:

Indoor Use Only
2
Category II
2000m
10 – 80% non-condensing

Dimensions:

18.2” (46cm) high x 7” (18cm) wide x 12” (31cm) deep

Shipping Dimensions:

20” (51cm) high x 13” (33cm) wide x 25” (64cm) deep

Instrument Weight:

17 lbs (7 kg)

Shipping Weight:

50 lbs (23 kg)

Sample Container Volume:

350mL

Shear Rate Accuracy:

+/- 0.01 RPM

Torque Accuracy:

+/- 0.5 dial reading from 1 to 260 degrees

Operating Speeds:

0.01 – 1000 RPM when PC controlled

PREFACE

Shear Rate Range: Sec-1 = k3N
Where: N = RPM, k3 = Shear Rate Constant
(k3 values are listed in the Calculation Section of the manual)
Rotor/Bob
Configuration
N = 0.1 RPM
N = 0.2 RPM
N = 0.3 RPM
N = 0.6 RPM
N = 1.0 RPM
N = 2.0 RPM
N = 3.0 RPM
N = 6.0 RPM
N = 10 RPM
N = 20 RPM
N = 30 RPM
N = 60 RPM
N = 100 RPM
N = 200 RPM
N = 300 RPM
N = 600 RPM
N = 1000 RPM

R1 B1
0.17
0.34
0.51
1.02
1.70
3.40
5.11
10.2
17.0
34.0
51.1
102
170
340
511
1021
1702

Shear Rate for Specified RPM (sec-1)
R2 B1 R3 B1 R1 B2 R1 B3
0.54
0.04
0.04
0.03
1.08
0.08
0.08
0.05
1.63
0.11
0.11
0.08
3.25
0.23
0.23
0.16
5.42
0.38
0.38
0.27
10.84
0.75
0.75
0.54
16.27
1.13
1.13
0.80
32.5
2.26
2.26
1.61
54.2
3.77
3.77
2.68
108.5
7.54
7.54
5.36
162.7
11.3
11.3
8.04
325.4
22.6
22.6
16.1
542
38
38
26.8
1085
75
75
53.6
1627
113
113
80.4
3254
226
226
161
5423
377
377
268

R1 B4
0.03
0.05
0.08
0.16
0.27
0.54
0.80
1.61
2.68
5.36
8.04
16.1
26.8
53.6
80.4
161
268
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Shear Stress Range
Shear Stress Range, dynes/cm2
Rotor/Bob Configuration R1B1
R2B1
R3B1
R1B2
o
F 0.2 θ = 1
1.02
1.02
1.02
2.01
F 0.2 θ = 300o
307
307
307
605
o
F 0.5 θ = 1
2.56
2.56
2.56
5.04
o
F 0.5 θ = 300
766
766
766
1510
o
F1 θ = 1
5.11
5.11
5.11
10.1
o
F1 θ = 300
1533
1533
1533
3022
o
F2 θ = 1
10.22
10.22
10.22
20.1
o
F2 θ = 300
3066
3066
3066
6044
o
F3 θ = 1
15.3
15.3
15.3
30.2
o
F3 θ = 300
4600
4600
4600
9067
o
F4 θ = 1
20.4
20.4
20.4
40.3
o
F4 θ = 300
6132
6132
6132
12,090
o
F5 θ = 1
25.6
25.6
25.6
50.4
o
F5 θ = 300
7665
7665
7665
15,100
o
F10 θ = 1
51.1
51.1
51.1
100.7
o
F10 θ = 300
15330
15330
15330 30,200

R1B3
4.1
1225
10.2
3060
20.4
6125
40.8
12,250
61.3
18,400
81.7
24,500
102
30,600
204
61,200

R1B4
8.2
2450
20.4
6140
40.9
12,300
81.8
24,500
123
36,800
164
49,100
205
61,400
409
123,000

Note: For the bob and rotor dimensions referenced in the above shear rate and shear
stress tables, see the Dimensions and Constants Table in the Operation Section
of this manual.

Optional Accessories
35-175

Kit, Calibration: Used to calibrate the torque measuring system on the Chandler
Model 3530 Viscometer. Kit includes a supporting bracket, 1.00 cm radius spool
for bob shaft, five metric weights, and case.
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Safety Requirements
READ BEFORE ATTEMPTING OPERATION OF INSTRUMENT
The Chandler Engineering Model 3530 Viscometer is designed for operator safety.
To ensure safety:
•
•
•
•
•
•
•
•
•
•
•
•
•

Always position the instrument in such a manner that allows easy access to the power
cord.
Post signs where the instrument is being operated to warn non-operating personnel.
Read and understand instructions before attempting instrument operation.
Observe caution notes!
Observe and follow the warning labels on the instrument.
Never exceed the instrument maximum temperature ratings.
Always disconnect main power to the instrument before attempting any repair.
Appropriately rated fire extinguishers should be located within close proximity.
Personal Protection Equipment (PPE) should be used when operating this instrument.
It is the user’s responsibility to ascertain the potential hazards of the samples under test.
Consult the appropriate MSDS and follow all PPE recommendations, and dispose of
samples safely and appropriately.
Do not handle the sample cup when the rotor is turning.
Before attempting to operate the instrument, the operator should read and understand this
manual.
If the instrument is not used in accordance to this manual, the safety of the instrument
may be impaired.
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Symbols Used on Equipment
Symbol

Meaning
Protective Conductor
Terminal

On (Supply)

Off (Supply)
Documentation must be
consulted in all cases
where this caution symbol
is marked.

Where to Find Help
In the event of problems, contact your local sales representative or Chandler Engineering:
•
•
•
•

Telephone:
Fax:
E-mail:
Website:

918-250-7200
918-459-0165
chandler.sales@ametek.com
www.chandlereng.com

Instrument training classes are also available.

PREFACE
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Section 1 – Installation
Unpacking the Instrument
Remove the instrument from the packing crate carefully. The unit comes fully equipped with
all the necessary components and ordered spare parts. Make sure that no parts are lost when
discarding the packing materials. Place the instrument on a firm table, close to the required
electrical outlets.
After the instrument is removed from the shipping crate, the equipment and spare parts
should be checked against the packing list to ensure that all parts have been received and
none are damaged.
Note: File an insurance claim with your freight carrier if damage has occurred
during shipping. Verify all parts shown on the enclosed packing list have been
received. If items are missing, please notify Chandler Engineering
immediately.

Utilities Required
100 - 240 VAC
50/60 Hz

Tools/Equipment Required
Small flat-head screwdriver

Setting up the Instrument
1. Check and ensure the locking nut (35-0112) is finger tight to prevent the stage (35-0101)
from slipping before starting the instrument. Caution: Failure to do so may cause the
stage and sample cup to slip and potentially spill the sample.
2. Plug the power cord into the rear of the instrument.
3. Plug the power cord into a properly rated electrical outlet.
4. Attach the bob and rotor.
5. Attach the serial cable to the back of the instrument labeled “Data”.
6. Attach the RS-232 three wire isolator to the free end of the serial cable and attach the
isolator to the computer.
7. Install the software on the computer (see complete software installation instructions
below).
8. Perform a software calibration on the instrument (the instrument is tested and calibrated
at the factory before shipment but must still be automatically calibrated to the software).
See the Maintenance Section of this manual for complete calibration instructions.
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Software Installation
The Model 3530 viscometer can be operated remotely via PC serial interface, using the
supplied Rheo 3000 software. To install the software, the following minimum equipment is
required:

Minimum PC Requirements
•
•
•
•
•
•

Windows 98 or later
300MHz Intel Pentium® Processor
128 MB RAM
800x600 Minimum Display Resolution
Standard RS232 Serial Port
CD-ROM for Software Installation

Installation Procedure
1. Insert the Rheo 3000 CD into the CD drive of the computer. If the installer does not
automatically appear, run the Setup.exe file from the Start menu. The installation
window shown below will appear. Click “Next” to continue.

2. Read the license agreement shown in the screen on the following page. The terms of the
agreement must be accepted before the installation can continue. Click “I agree” to
accept the license agreement and then click “Next” to continue with the installation.

SECTION 1 – INSTALLATION
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3. Enter you name and company name, then press “Next” to continue.

4. The installer is now ready to install Rheo 3000 on the computer. Confirm the installation
by clicking “Next” to continue.

1-4

SECTION 1 – INSTALLATION

5. The screen below will appear indicating the progress of the installation.

6. When installation is complete, the screen below will appear. Click “Close” to exit the
installer.

SECTION 1 – INSTALLATION

7. Click on the Rheo 3000 icon (shown here) to start the software.
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Section 2 – Operating Instructions
Note: Accurate measurements are dependent upon having a clean and wellmaintained instrument. Always remove the rotor and bob for cleaning after
each use of the instrument, and protect them from dents, scratches, abrasions,
and other damage.

Operation
Test Preparation
1. Fill the sample cup with the fluid to be tested up to the 350mL scribed line.
2. Place the sample cup on the sample cup stage and rotate the cup until the three feet on the
cup are engaged in the holes.
3. Raise the sample cup and stage until the fluid level meets the
scribed line on the rotor. Tighten the locking nut on the sample cup
table.

Manual Instrument Operation
1. Operate the motor at one of the 16 preset speeds. Turn
the rotary dial to the desired speed. Initially, running at high
speed may be beneficial to quickly fill the annular space between
the rotor and bob. This is especially beneficial for high viscosity
fluids.
2. Observe the reading from the dial in the instrument by viewing through the illuminated
lens. The pointer will indicate the dial reading. Allow the reading to stabilize before
recording the result. Record the observation as a dial reading at the selected RPM (shear
rate).
3. A schedule of increasing motor speeds (shear rates) is recommended to study “unsheared” fluid viscosity. Alternately, a schedule of decreasing motor speeds is used to
study “sheared” viscosity behavior. Consult the industry standard for a recommended
schedule of test speeds.
4. Use the Rotation Inhibit switch (manual switch located behind the Sample Cup holder) to
stop motion. This switch is primarily used for Gel Strength tests where the motor must be
stopped and then started. When power is first applied to the motor, the internal magnets
must be aligned. This realignment causes the motor to “jerk” and this jerk can invalidate
a Gel Strength Test. The Inhibit switch stops motion while keeping power applied to the
motor maintaining magnet alignment. When the motor must be stopped during a test,
toggle the Inhibit switch to the “ON” position to stop motion. To start motion again (at
the speed selected by the rotary dial), toggle the Inhibit switch to the “OFF” position.
This switch has no effect when the instrument is operated via the Rheo3000 software
unless Rotor Control is set to “Dial (Manual)”.
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Automated Instrument Operation
Note: This section is intended to provide a brief overview of how to start an
automated test. The complete functionality of the software is described in the
Software Operation section below.
1. Attach the serial cable from the back of the instrument labeled “Data” to the computer.
2. Create the desired schedule using the Edit Schedule command under the Setup menu, or
select an existing schedule by using the Open Schedule command in the File menu.
3. In the “Log File” section of the main screen, specify a file name for the test and the log
interval.
4. Under the “Setup” menu, in the “User Parameters” tab, set the desired rotor speed control
units and viscosity stabilization criteria.
5. Under the “Setup” menu, in the “Log File Header” tab, enter any desired test information.
This information will be appended to the data file.
6. Verify that the sample is in place and ready for measurement.
7. On the main screen, choose PC (automatic) under “Rotor Control”. Click the “Start
Schedule” button.
8. After “Start Schedule” has been selected, the following screen will appear. Click “Yes”
to continue.

9. When “Yes” is selected, the screen below will appear. In the “File Name” box that is
highlighted, enter the desired file name for the test data. When the file name has been
entered, click the “Open” button.

SECTION 2 – OPERATING INSTRUCTIONS
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10. If the checkbox in the “Log File Header” section of the “Setup” screen is selected, then
the following screen will appear. If the file header information needs to be changed,
select “Yes”.

11. When “Yes” is selected, the following screen appears, allowing entry of the header
information. Enter the information under “File Header Information”, then click “OK” to
proceed with the test.
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12. Allow the test to run. The test data may be displayed on the screen during test by
selecting the “Plot” tab and selecting the desired plot from the “Plot” menu.

Test Completion and Clean-up
1. Clean the instrument thoroughly upon completion. Use water only for the outside of the
instrument.
2. Remove the rotor by holding the top portion of the rotor shaft and unscrewing the rotor
nut clockwise. Avoid hitting the bob as the rotor is removed since it may damage the bob
shaft. The machined surfaces of the rotor that fit into the rotor shaft must be kept clean
and without scratches to preserve the accurate alignment of the rotor.
3. Remove the bob by turning counterclockwise until the rotation is impeded by the
mechanical stop. Twist the bob while gently pulling downward. Always clean the bob
and remove any debris from the tapered hole. It is very important to keep the mounting
surface in the bob very clean for proper mechanical alignment of the bob.
4. To replace the bob, push gently upward and twist counterclockwise to lock the bob to the
bob shaft.
Caution: Residual fluids within a hollow bob can be trapped when the bob is
attached to the bob shaft. Excessive heat can vaporize this fluid and cause
the bob to be under extreme pressures with possible catastrophic failure.
This viscometer is designed for use with fluid temperatures up to 194oF
(90oC).

Software Operation
The Model 3530 viscometer can be operated remotely via PC serial interface, using the
supplied Rheo 3000 software. This section provides detail on each of the software functions.
Online documentation is also available under the Help menu.

Major Features of Rheo 3000
•
•
•
•

Remote control of a stepping motor system to provide rotor speeds (step changes, linear
ramps, constant speed)
Automatic calibration of torque transducer using a Newtonian calibration oil
Data storage in an Excel compatible file (*.CSV)
Automatic calculation of Bingham Plastic, Power Law Parameters.

SECTION 2 – OPERATING INSTRUCTIONS
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Menu System
File Menu

The File menu provides access to the following commands:
•
•
•
•
•

•
•

Open Instrument - Opens an existing instrument file, effectively connecting the
software to the rheometer.
Close Instrument - Closes an open instrument file, effectively disconnecting the
software from the rheometer.
Open Schedule - Used to open an existing test schedule that is stored on the disk drive.
Test schedules use a proprietary binary file format that is only recognizable by the Rheo
software.
Save Schedule As - Used to save an open schedule file to a new file name.
Log and Plot Data - Starts logging data to a ".csv" file and resets the data plot. The
".csv" file extension is recognized my Microsoft Excel. Thus, a log file may be opened by
double-clicking on its icon from within Windows, or from within Excel. Raw data is
logged to the specified file, as well as Bingham Plastic and Power Law calculations.
Open Data Log File - Opens an existing data log file, displaying its contents in the data
plot and in the calculation grid.
Exit - Exits the program.
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Setup Menu

The Setup menu provides access to the following commands:
•
•

•
•

Communication Settings - The communication settings sub-menu allows assignment of
a specific PC serial port to the Model 3530 Instrument.
Initialize 3500 Controller - This menu selection allows the Motor Controller to be
reinitialized to factory default settings, effectively reloading the program stored in its
electronic memory. Selecting this option will bring up the Controller Initialization
Prompt.
Normal Operation - When selected, this option allows the software to communicate
with the instrument.
Simulation Mode - When selected, this option allows the software to operate without the
presence of an instrument. If an instrument is connected, it will be ignored in simulation
mode, and no rheological tests can be performed without first selecting Normal
Operation.

Plot Menu

The plot menu is only visible when the Plot Tab is selected. It allows the user to select which
data set to display in the on-screen chart. This menu is accessible via the Main Menu, or by
right-clicking on the chart area. It allows the following selections:
•
•
•
•
•
•
•

Shear Stress vs. Shear Rate - Displays a chart of Shear Stress vs. Shear Rate on the
main screen.
Shear Rate vs. time - Displays a chart of Shear Rate vs. Time on the main screen.
Shear Stress vs. Time - Displays a chart of Shear Stress vs. Time on the main screen.
Viscosity vs. time - Displays a chart of Viscosity vs. Time on the main screen.
Torque vs. time - Displays a chart of Torque vs. Time on the main screen.
Scale - Allows selection of linear or logarithmic scaling. Scaling applies to both the X
and Y axis of the chart.
Markers - When selected, a marker for each data point on the chart is shown.

SECTION 2 – OPERATING INSTRUCTIONS
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Security Menu

The security menu allows creation of different user access levels. If enabled, an
Administrator password is required for the creation of custom schedules.
To prevent a user from entering custom schedules, the Restricted User setting must be
selected. When selecting Administrator, a password prompt will appear, unless no
Administrator password has been specified.

To specify an Administrator password, select Change Password. The following prompt will
appear:

To disable the administrator password protection, simply enter the Administrator password in
the Old Password entry box and leave the New Password and Confirm entries blank.

Window Menu

The Window menu allows selection of an open instrument. As multiple instruments are
open, the Window Menu displays the name of each instrument. Selecting an instrument in
the Window Menu will place it in front of any other open instruments.
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Help Menu

The Help menu provides access to the online help system.

Main Software Tab
The Main Tab provides feedback and allows the user to control a test. It is divided into the
following sections:

Log File

Allows a user to specify the following parameters for data logging and trending:
•

•

The Raw Data Log Interval parameters define how often a data point for each
measurement is written to the log file.
o Between Ramps - Defines the log interval for manual operation, or for
schedule steps where the raw data checkbox is selected but the model data
checkbox is not selected.
o During Ramps - Defines the raw data log interval for schedule steps where the
raw data and model data checkboxes are selected.
Elapsed Time displays the elapsed time in hours, minutes and seconds since an active
log file was started.

SECTION 2 – OPERATING INSTRUCTIONS
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Rotor Control

Allows a user to start and stop a schedule, or control the rotor manually using the following
parameters:
•
•
•
•
•
•

When PC (Manual) Control is selected from the dropdown list, the rotor may be
controlled manually through the software. In this mode, any parameters specified in the
loaded schedule are ignored.
When PC (Automatic) Control is selected, the rotor is controlled via the current
schedule.
When Dial (Manual) Control is selected, the rotor is controlled via the instruments builtin speed control dial.
Shear Rate or Rotor Speed allows the user to manually enter a desired rotor speed,
when Manual Mode is selected. When Automatic mode is selected, the shear rate from
the current schedule stage is displayed.
Actual Shear Rate or Rotor Speed displays the current rotor speed.
Accel allows the user to prescribe an acceleration/deceleration rate. If the motor stalls
during a run, the acceleration rate should be decreased to 250 or lower.

Calculations

Displays values for the following measured and calculated values:
•
•
•

Dial Reading (Degrees) - Measured directly from the dial.
Torque (Dyne - cm) - Based on a lookup table, generated during instrument calibration.
Shear Stress (Dyne/cm^2) - Based on the following formula:
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•

Viscosity (cP) - Apparent Viscosity, based on the following formula:

Calculation Grid

The Calculation Grid displays a list of automatically generated Bingham Plastic and Power
Law calculations.

Model Calculations
The Rheo 3000 Software provides automated calculation of the Bingham Plastic and Power
Law rheological models. These values are logged to a data file, if the logger is enabled
during a test.
To generate these calculations the following steps are performed:
1. The user must define a schedule that includes a series of contiguous checked boxes in the
"Log Model Data" column.
2. The schedule is executed by pressing the “Start Schedule” button on the Main Tab.
3. For each schedule step with the check box selected in the "Log Model Data" column, a
data point depicting shear stress vs. shear rate is collected. Each data point is generated
by averaging data (1 sample per second) over a specific time window. The user can
specify when this window begins for each schedule step with the Viscosity Stabilization
Criteria entry under the Preferences Tab. The window ends when the next step in a
schedule is encountered. For example, if the user has entered 15 seconds for the Viscosity
Stabilization value and a schedule step has a duration of 20 seconds, data will be
collected once per second over the last 15 seconds of the schedule step and the average
will become a data point for Bingham Plastic and Power Law calculation.
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4. When either a schedule step with an unchecked box in the "Log Model Data" column is
encountered, or the end of a schedule is encountered, the series of data points are used to
generate a set of Power Law and Bingham Plastic values.
5. Each valid calculation is recorded in the data log file and displayed on the Calculation
Grid of the Main Tab.

Rheological Models
The Rheo 3000 software automatically calculates values for the following rheological
models:

Bingham Plastic Model
The Bingham Plastic Model is expressed as:
τ = YP + PV(γ)

Where: τ

= Shear Stress

YP = Yield Point
PV = Plastic Viscosity
γ

= Shear Rate

For these calculations, the Rheo 3000 software automatically collects data at a rate of one
sample per second for each desired schedule step. The average of this data is calculated for
each schedule step and applied to the following formula:
PV = ((Σγavg * Στavg) - (N * Σγavgτavg)) / ((Σγavg)² - (N * Σγavg²))
YP = ( (Σγavgτavg * Σγavg) - (Στavg * Σγavg²))/((Σγavg)² - (N * Σγavg²))

Where:

τavg

= Average Shear Stress for an individual schedule step during
the data collection period.

γavg = Average Shear Rate for an individual schedule step
N

= Number of schedule steps

The accuracy of the model is expressed as:
R² = 1 - (Σεi²/(Σγavg² - (Σγavg)² / N)
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Where εi represents the difference between the measured shear stress and the calculated shear
stress using the Bingham Plastic equation τ = YP + PV(γ) for schedule step i.
For a perfect model, R² = 1.

Power Law Model
The Power Law Model is expressed as:
τ = K * γn
Where: τ

= Shear Stress

K

= Consistency

n

= Power Law Exponent

γ

= Shear Rate

For these calculations, the Rheo 3000 software automatically collects data at a rate of one
sample per second for each desired schedule step. The average of this data is calculated for
each schedule step and applied to the following formula:
n = ((ΣLog10(γavg) * ΣLog10(τavg)) - (N * ΣLog10(γavg)Log10(τavg))) / ((ΣLog10(γavg))² - (N *
ΣLog10(γavg)²))
K = 10^( (ΣLog10(γavg)Log10(τavg) * ΣLog10(γavg)) - (ΣLog10(τavg) *
ΣLog10(γavg)²))/((ΣLog10(γavg))² - (N * ΣLog10(γavg)²))
Where:

τavg

= Average Shear Stress for an individual schedule step during the
data collection period.

γavg = Average Shear Rate for an individual schedule step
N

= Number of schedule steps

The accuracy of the model is expressed as:
R² = 1 - (Σεi²/(ΣLog10(γavg)² - (ΣLog10(γavg))² / N)
Where εi represents the difference between the base-10 logarithm of measured shear stress
and the calculated shear stress using the Power Law equation τ = K * γn for schedule step i.
For a perfect model, R² = 1.
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Herschel-Bulkley Model
The Herschel-Bulkley Model is expressed as:
τ = YP + K * γn
Where τ

= Shear Stress

YP

= Yield Point

K

= Consistency

n

= Power Law Exponent

γ

= Shear Rate

For these calculations, the Rheo software automatically collects data at a rate of 1 sample per
second for each desired schedule step. The average of this data is calculated for each
schedule step and applied to a nonlinear least-squares regression analysis to arrive at the
model described above.

Casson Model
The Casson Model is expressed as:
F1/2 = k0 + k1D1/2
Where

F

= Shear Stress

k0

= Yield Stress

k1

= Plastic Viscosity

D

= Shear Rate

For these calculations, the Rheo software automatically collects data at a rate of 1 sample per
second for each desired schedule step. The average of this data is calculated for each
schedule step and applied to formulas similar as used in the Bingham Plastic model except
the square root of Shear Stress and Shear Rate are used.
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Data Plotting

Data plotting is performed on the Plot Tab, during a test. When any measurement data is
logged to a file, it is simultaneously displayed on the chart. When a test is stopped and
restarted, the contents of the chart are cleared. The following plots may be selected, via the
Main pull down Menu, or by right-clicking on the chart.
•
•
•
•

Shear Stress vs. Shear Rate may be displayed on the main screen, as shown above.
Shear Rate vs. Time allows the user to verify historical shear rate data against the
prescribed schedule.
Shear Stress vs. Time displays the shear stress values for the current test.
Viscosity vs. Time may also be displayed.

Plot Toolbar
The Plot Toolbar provides flexibility in manipulating the displayed contents of the chart.
The following selections are provided.
•

Enable X-Axis Tracking - Causes the X-Axis to automatically adjust its scale.

•

Disable X-Axis Tracking - Causes the X-Axis to stop automatically adjusting its
scale.

•

Manual Axis Scaling - Pressing this button displays the manual axis scaling
screen.
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•

Undo - Restores the plot settings, ignoring the last action. A drop-down menu
allows multiple undo operations with a single mouse click.

•

Redo - Restores the plot settings, ignoring the last undo action. A drop-down
menu allows multiple redo operations with a single mouse click.

•

Save as Default Setting - Saves the current plot configuration to the instrument
file.

•

Scroll (Axes) - Selecting this button allows scrolling of the X and Y axes by
clicking and dragging the desired axis scale.

•

Zoom (Axes) - Selecting this button allows zooming of the X and Y axes by
clicking and dragging the desired axis scale.

•

Zoom In - Zooms in toward the center of the chart.

•

Zoom Out - Zooms out from the center of the chart.

•

Zoom Box - Zooms in on the chart around a window that is drawn by clicking and
dragging.

•

Cursor - Displays or hides the data cursor. Note: Selecting a data cursor
effectively disables X-Axis Tracking. To re-enable X-Axis Tracking, press the Enable
X-Axis Tracking button.

•

Copy to Clipboard - Copies the displayed chart contents to the windows clipboard
for pasting into other applications as a bitmap image.

•

Save as Image - Allows the displayed chart contents to be saved to a bitmap
(.bmp), JPEG (.jpg) or enhanced metafile (.emf) file.

•

Print - Automatically rescales and prints the displayed chart contents on the default
printer. The Test File Name is printed at the bottom of the page, and the Log File
Header contents are printed at the top of the page.

•

Show/Hide Y-Axis Titles - Allows the user to hide Y-Axis titles to reserve more
screen space for plot data.

•

Show/Hide Legend - Allows the user to hide the legend to reserve more screen
space for plot data.

•

Show/Hide Y Values in Legend - Allows the user to display or hide current Y
Values for each visible plot in the legend (if visible).
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Manual Axis Scaling Screen

The Manual Axis Scaling Screen provides precise manual control over the displayed range of
each plot.
• Y-Axis - Allows selection of individual plots in a list. By clicking on a plot title,
auto-scale may be selected or deselected. If auto-scale is not selected, a maximum
and minimum displayed scale value may be entered for the selected plot.
• X-Axis - Allows manual or auto-scaling of the X-Axes.
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Preferences Tab

The Preferences Tab provides the following adjustable User Parameters.
•

n and K' Units - Defines the units to display the Power Law Model results, both on
the Main Tab and in the Data Log File.

•

YP and PV Units - Defines the units to display the Bingham Plastic Model results,
both on the Main Tab and in the Data Log File.

•

Modeled Shear Rates - The modeled viscosity at each of these shear rates is logged
to the Data Log File for each Rheological Model.

•

Rotor Speed Control Units - Allows rotor speed to be controlled as RPM or 1/sec.

•

Viscosity Stabilization Criteria - Viscosity stabilization refers to the stabilization of
measured Shear Stress that occurs after a change in Shear Rate. See Bingham Plastic
and Power Law Calculations for more information on how this feature is used. The
length of the stabilization period is defined by the user.
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•

Schedule Shear Rate Acceleration - When this value is set to zero, it is overridden
by the Accel field on the Main Tab. If a higher value is selected, each shear rate
change within a schedule will utilize the specified period to provide a smooth, linear
change in rotor speed. The initial acceleration (acceleration to the rotor speed
prescribed by the first schedule step) always uses the acceleration value specified in
the Accel field of the Main Tab.

•

File Header Information - Information to be included at the top of each data log file
is entered here.

NOTE: The following parameters are only available if the 3500-04 Temperature Control
option is selected.
•

Maximum Temperature - Defines the temperature at which the "Over Temperature"
alarm will display on the main screen. This value also represents the maximum
allowable temperature entry value for a schedule or manual temperature control.

•

Temperature Display Units - Allows the selection of degrees Fahrenheit, Celsius or
Kelvin. This selection applies to the log file, as well as the schedule, alarm limits and
any other place that temperature is displayed. Temperature display units may not be
changed while data is being logged to a file. This promotes concurrency between the
units advertised at the top of each column and the units for any data being logged.
The temperature controller on the instrument may be configured to display degrees
Celsius, Kelvin or Fahrenheit. The display unit setting on the front panel of the
controller functions independently of the software unit selection. Thus, a different
temperature unit may be displayed on the front panel of the controller, than on the
main screen of the Rheo software. Refer to the temperature controller manual for
details on how to change the units displayed on the front panel.

•

Temperature Stabilization Criteria - When "Advance with Temperature" is
selected within a schedule, and the measured sample temperature reaches a value
within this specified tolerance, the schedule execution will advance to the next
schedule step. If this target is not reached, the schedule will advance when the
specified duration for the given schedule step expires
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Schedule Entry Tab

The Rheo software system allows user-defined schedules for automatic test control.
Schedules are created and edited using the Schedule section of the Setup screen. Cells
may be edited individually. Entire rows and groups of rows may be cut, copied and
pasted.
A toolbar at the top of the schedule grid provides the following selections:
•

Open Schedule File - Opens a previously defined schedule file.

•

Save Schedule As - Creates a copy of the current schedule with a new filename.

•

Cut - Makes a copy of the current selection, then deletes the selection.

•

Copy - Makes a copy of the current selection.

•

Paste - Pastes the copied selection onto the selected location.

•

Undo - Restores the schedule to a previous state.
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•

Redo - Reverses the Undo action

•

Schedule Setup Wizard - Opens the Schedule Setup Wizard Screen.

The Apply button in the lower-right corner of this screen automatically performs the
following actions when pressed:
1. Save the current schedule file.
2. Apply the changes to the working schedule. A schedule may be edited as it is
executed. The changes take effect when the Apply button is pressed.
A popup menu appears when the user presses the right mouse button over the schedule
grid area. A schedule may also be verified visually as it is being edited via the Plot
Schedule Tab.
Each step of a schedule contains the following information:
•

Start Time - The relative time from the beginning of the schedule that a step will
begin. This parameter is automatically calculated and updated by the Rheo
program.

•

Shear Rate - Defines the shear rate for a given schedule step.

•

Duration - Defines the duration of a given schedule step in minutes.

•

Rotor Speed - Displays the rotor speed in RPM, based on the desired shear rate.

•

Log Model Data - Allows the user to specify which schedule steps are used for
Bingham Plastic and Power Law calculations.

•

Log Raw Data – Allows the user to specify whether or not to log and plot data
for any given schedule step.
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Schedule Setup Wizard

The Schedule Setup Wizard provides a simple way to set up a standard test. To start the
wizard as an Administrator, select the rightmost button of the toolbar on the Schedule Entry
Tab. If Restricted User is selected from the Security Menu, the wizard screen will appear
automatically when the Schedule Entry Tab is selected.
To create a schedule using the wizard, simply follow the on-screen instructions. The
following schedule types are provided.
• ISO 13503-1:2003 (E) - Allows a schedule of user-defined duration to be created
with either increasing or decreasing shear rate ramps. Any test duration may be
selected. Ramp schedules are determined according to the ISO standard.
• API RP 39 - Provides an implementation of the API standard. Shear rate ramps are
performed from 100 1/sec to 75, 50, 25, 50, 75 and 100 1/sec. Any test duration may
be selected.
• Constant Shear Rate - Any constant shear rate and duration may be specified.
• Edit Schedule Manually - Closes the wizard and opens the Schedule Entry Tab.
(Requires Administrator password if Restricted User is selected from the Security
Menu.)
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Schedule Plot Tab

A schedule may be verified visually via the Plot Schedule Tab. The shear rate or rotor speed
set point is displayed over time. The shaded areas in the plot represent data collection
windows for raw data and model data.

Manual Viscosity Calculations
Viscosity, by definition, is shear stress divided by shear rate. There are three different
methods of calculating viscosity using the Model 3530. Each method requires different
constants to be used in the calculations. The constants are outlined below, followed by a
detailed explanation of the three methods used for viscosity calculation. Additionally, some
common oilfield viscosity computations are provided for reference.
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Dimensions and Constants for Viscosity Calculations
Rotor/Bob Configuration
Rotor Radius, Ro, cm
Bob Radius, Rj, cm
Bob Height, L, cm
Shear Gap, in Annulus, cm
Radii Ratio, Rj / Ro
Overall Instrument Constant, K
Shear Stress Constant for Effective
Bob Surface k2, cm-3
Shear Rate Constant k3, sec-1 per rpm

R1 B1
1.8415
1.7245
3.800
0.1170
0.9365
300.0
0.01323

R2 B1
1.7588
1.7245
3.800
0.0343
0.9805
94.18
0.01323

R3 B1
2.5866
1.7245
3.800
0.8261
0.667
1355
0.01323

R1 B2
1.8415
1.2276
3.800
0.6139
0.666
2672
0.0261

R1 B3
1.8415
0.8622
3.800
0.9793
0.468
7620
0.0529

R1 B4
1.8415
0.8622
1.900
0.9793
0.468
15,200
0.106

1.7023

5.4225

0.377

0.377

0.268

0.268

Standard F1 Torsion Spring η= Kfθ/N

Model 3530
TORSION SPRING CONSTANTS
TORSION
SPRING
ASSEMBLY

TORSION
SPRING
CONSTANT
k1

TORSION
SPRING
FACTOR
f

MAXIMUM
SHEAR STRESS
WITH B1 BOB

F0.2

77.2

0.2

307

F0.5

193.0

0.5

766

F1

386.0

1.0

1533

F2

772.0

2.0

3066

F3

1158.0

3.0

4600

F4

1544.0

4.0

6132

F5

1930.0

5.0

7665

F10

3860.0

10.0

15330

Method 1: Viscosity Calculation in Terms of an Overall Instrument Constant
Viscosity (cP) = K * f * (θ/N)
Where:

K = overall instrument constant (units of dyne * sec * RPM per cm2 * degree of
deflection)
f = torsion spring factor (see Spring Constants Table above)
θ = Model 3530 dial reading
N = rate of revolution of the outer cylinder, RPM
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Method 2: Viscosity Calculation in Terms of Three Instrument Constants
This method calculates the viscosity based on instrument constants for torsion spring, bob
surface, and shear gap.

 k *k 
 
Viscosity (cP) =  1 2  * 100 *  
N
 k3 
Where:

k1 = torsion spring constant (see Spring Constants Table above), dyne-cm/degree
k2 = shear stress constant for effective bob surface, cm-3
k3 = shear rate constant, sec-1/RPM
θ = Model 3530 dial reading
N = rate of revolution of the outer cylinder, RPM

Method 3: Viscosity Calculation in Terms of Shear Stress Divided by Shear Rate
Shear stress (dynes/cm2) = k1 * k2 * θ
Shear rate (sec-1) = k3 * N
Viscosity (cP) = Shear stress * 100
Shear rate

Common Oilfield Computations
Note: These computations are valid only with the standard R1/B1 configuration. A
spring other than F1 may be used if the dial readings are multiplied by the
proper "f" factor.
Apparent Viscosity (cP)
AV = θ600 RPM / 2
Plastic Viscosity (cP)
PV = θ600 RPM - θ300 RPM
Yield Point - approximate value (lb/ft2)
YP = θ300 RPM - PV
Yield Point – exact value (lb/ft2)
YP = 1.065 * (θ300 RPM - PV)
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Section 3 – Maintenance
Tools Required
Standard mechanics tool set

Cleaning and Service Tips
•
•
•

The rotor and bob should be thoroughly cleaned after each test. Care should be taken to
ensure that the bob shaft does not become bent.
Never replace the power cord with an inadequately rated power cord (see section 5 –
Replacement Parts for the Chandler Engineering part number).
Maintenance should only be performed by qualified personnel.

Manual Calibration Procedure
Note: The spring zero and span should be adjusted after any maintenance is
performed on the Model 3530. The spring zero and span should be adjusted
BEFORE the automatic calibration is performed using the software.
1. The spring zero and span must be adjusted using a calibration fixture or known viscosity
fluid.
2. Verify the spring calibration by attaching the pulley frame from the calibration kit to the
posts on the viscometer.
3. Attach the calibration disc and thread to the tapered end of the bob shaft and hang the 10gram weight over the pulley with the anchor on the string attached to the disc.
4. Adjust the height of the frame on the vertical support shafts until the string is horizontal
between the disc and the pulley.
5. Record the dial reading.
6. Repeat the process using the 20 gram, 50 gram, 100 gram weights and with all weights
removed.
7. Refer to the table on the following page for the dial reading limits during spring
calibration.
8. If the dial reading does not fall within the allowable tolerances, a calibration adjustment
must be made. See the Calibration Adjustment section below.
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Weight (grams)
0
10
20
50
100

Spring Tolerances for Calibration (Dial Reading)
0.2 Spring
0.5 Spring
1.0 Spring
0 ± 0.5
0 ± 0.5
0 ± 0.5
127 ± 2
51 ± 1
25 ± 1
254 ± 2
102 ± 2
51 ± 1
254 ± 2
127 ± 2
254 ± 2

2.0 Spring
0 ± 0.5
12.5 ± 1
25 ± 1
64 ± 1
127 ± 2

Software Calibration

Calibration Overview
The Model 3530 Viscometer uses an automated software calibration procedure, which
relates angular bob shaft deflection to shear stress. Measurements made at a variety of
rotor speeds comprise a lookup table for the software to use when measuring shear
stress. A pre-defined schedule takes the instrument from low speed to high speed, and
back to low speed, waiting for a user-defined period seconds at each of 40 pre-defined
speeds (20 increasing and 20 decreasing) to allow for measurement stabilization and
data averaging. The result is a curve from which system linearity and hysteresis can be
inferred.
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Since this curve provides a reasonable impression of the instrument performance, a
system of metrics has been established to compare what can be construed as a “good”
calibration to a “bad” one. These metrics include linearity, slope, intercept, hysteresis
standard deviation and maximum hysteresis.

System Linearity
The linearity of a calibration curve is noted by the value of R², which is an indication of
how precisely a straight line can be plotted against the calibration data using the linear
least-squares method. In general, an R² value of 1 indicates perfect linearity. An R²
value of slightly less than one is generally expected.
While the linearity can provide clues to the performance of the instrument, analyzing
the R² value of a given calibration only makes it possible to detect gross errors, such as
frozen bearings, etc.

Slope
Since a good calibration result is reasonably linear, the slope of the same line generated
by the least-squares method to produce R² provides an estimate of the spring constant in
dyne/cm² per degree. In turn, this constant can be used to predict the maximum
measurable shear stress by the formula τmax = slope (dyne/cm²) * 300 degrees.

Intercept
The intercept of the line generated by the least-squares method provides an indication
of sensor offset. Although any effects of a non-zero intercept are compensated for by
the calibration, the intercept should typically be near zero, because “re-zeroing” the
sensor can have an adverse effect on the effectiveness of a given calibration, otherwise.
If the offset is near zero, the sensor can be “re-zeroed” or “tared” without the need for
recalibration.

Hysteresis
Hysteresis provides an indication of overall friction in the system. When increasing the
bob shaft torque to a given value, the resultant angular deflection may be less than that
observed by approaching the same torque from a higher value. This is typically
assumed to be the result of friction, although other factors can influence the reported
hysteresis.
To characterize the hysteresis from a given calibration, each data point is compared
with the lookup table generated by the calibration procedure itself. Since the
calibration routine includes 1 data point for increasing shear rate and 1 data point for
decreasing shear rate at each pre-defined speed, each lookup table entry is determined
by the average of two bob shaft deflection measurements and the average of two shear
stresses.
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Standard Deviation
During and after calibration, the deviation of each data point (in dyne/cm²) from the
lookup table (shear stress vs. angular deflection) is recorded. Standard deviation is
calculated based on the data set containing these points. The formula for standard
deviation is defined as:



 (X − M )
(N −1)

2

=

, where M is the mean and N = the number of data points.

Since each pair of data points is generated by comparison to their averages, M=0.

Maximum Hysteresis
Maximum Hysteresis is defined as the largest deviation found in the calibration data set
from the calibration table. Whereas standard deviation provides a normalized
indication of the overall bearing friction, maximum hysteresis provides a meaningful
measurement of worst-case hysteresis.

Software Calibration Summary
Each of the parameters listed above are reported by the Rheo 3530 software. In
addition to reporting each of these values on-screen, they are also recorded, along with
all other calibration data and parameters, near the top of each individual log file.
Analysis of the maximum hysteresis, hysteresis standard deviation, R², slope and
intercept can provide a quick and easy verification of the state of an instrument, upon
recalibration.
User-defined parameters on the Calibration screen include:
•
•
•
•
•
•
•
•

Bob Height – Entered automatically when the correct rotor/bob combination is selected.
Bob Radius - Entered automatically when the correct rotor/bob combination is selected.
Rotor Radius - Entered automatically when the correct rotor/bob combination is
selected.
Fluid Viscosity - The known viscosity value of the calibration fluid.
Stabilization Time - Defines how long to wait between calibration steps before
recording the value from the encoder.
Auto Calibrate - Starts the auto-calibration sequence.
Save Calibration - Saves the most current calibration data to the hard drive, and instructs
the Rheo 5000 software to begin using the new values.
Zero Button – Automatically forces the current encoder reading to zero

Note: It is highly recommended that a manual dial calibration be completed before a
software calibration is performed.
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Serviceable Parts
Fuse Replacement
The main power fuse at the rear of the instrument may occasionally need to be replaced.
1. Unplug the power cord.
WARNING: Power must be disconnected to
prevent injury.
2. Verify that power to the instrument is OFF and
unplug the instrument from the electrical outlet
before proceeding.
3. Using a small flat-head screwdriver, pry open the
top of the main power switch.
4. Remove the fuse-holder.
5. Remove the old fuse and replace with a new fuse, part number C11037 (see Section 5 –
Replacement Parts for fuse rating and characteristic.)
6. Plug power cord into the power entry module located on the back of the instrument.
7. Turn on the instrument and verify the bob rotates.

Spring Assembly Replacement
1. Unplug power cord.
WARNING: Power must be
disconnected to prevent injury.
2. Screw in the #4-40 x 3 inch
screw shipped with the
instrument.
3. Loosen set screw #3. This set
screw is accessed by removing
the silver plug on the front of
the instrument. The dial
indicator must be rotated until
the set screw aligns with the
hole in the casting.
4. Carefully pull the spring
assembly out of the instrument.
5. Insert new spring assembly.
6. Tighten set screw #3.
7. Plug power cord into the power entry module located on the back of the instrument.
8. Calibrate the instrument with the new spring following the instructions in the Manual
Calibration Adjustment section.
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Bob Shaft Bearing Replacement
1. Unplug power cord.
WARNING: Power must be disconnected to prevent injury.
2.
3.
4.
5.

Remove the silver plug from the front of the instrument.
Loosen set screw #3 in the bushing.
Remove the torsion spring cap.
Loosen set screw #1 in the zero adjust
sleeve.
6. Remove the 6 top cover screws.
7. Remove the spring assembly taking care
not to stretch the spring.
8. Raise the gear box cover up and carefully
lay it over the side of the gear box. The
instrument can be laid on its side to
simplify this process and to minimize the
chance of damage to the attached wiring.
9. Remove the rotor.
10. Remove the bob.
11. Remove the 2 screws from the stand-offs
and carefully slide the brown optical
encoder away from the optical disc.
12. Remove the bearing splash guard by
sliding it straight down and off of the bob
shaft.
13. Remove the bob shaft snap ring by laying the instrument on its side and using a pointed
tool to remove the snap ring.
14. Remove the bob bearing shield.
15. Pull the dial and bob shaft assembly straight up out of the bearings. DO NOT bend the
shaft.
16. Carefully remove the bob shaft bearings.
17. Replace the bearings with new (or cleaned) bearings. DO NOT use oil or grease in the
bearings.
18. Reverse the procedure for re-assembly. Use great care to ensure the cleanliness of the
bearings and related components to prevent dial oscillations due to bearing drag.
19. Calibrate the instrument in the Manual Calibration Adjustment section.
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Manual Calibration Adjustment
Note: If the dial readings from the Manual Calibration are beyond the limits, an
adjustment to the calibration must be made as follows.
1. Refer to the diagram of set screws on the following page as the adjustments are made.
2. Remove the spring cap and loosen set screw #1 using a 1/16 inch hex wrench on the zero
adjust sleeve.
3. This loosens the upper spring clamp on the torsion spring assembly and allows the
effective spring length to be varied by raising or lowering the mandrel inside the spring.
4. If readings are too high, move the spring mandrel down by turning it clockwise. If
readings are too low, move the spring mandrel up by turning it counterclockwise.
5. Tighten set screw #1.
6. If the instrument ZERO must be adjusted, remove the spring cap and use a 1/16 inch hex
wrench to loosen set screw #2.
7. Remove all weights from the calibration fixture.
8. Rotate the knurled bushing until the dial reading is 0. Tighten set screw #2.
9. Repeat the calibration procedure with the weights.
10. If the instrument will not calibrate properly, check the bob shaft bearings and refer to
other potential problems listed in the Troubleshooting Guide.
Note: Calibration may require repetitive adjustments of the Span and Zero since they
are interrelated. Once the dial readings fall within the acceptable limits,
tighten all the set screws securely and replace the torsion spring cap.
11. Operate the instrument at 300 RPM with a 200cP fluid in the sample cup. The dial
oscillations should be less than 1 dial reading to verify the instrument is operating
properly. If not, clean or replace the bob shaft bearings.
Note: Dial oscillations can also be caused by a bent bob shaft or a damaged rotor
assembly. Additionally, a rotor shaft belt pulley that does not slide freely
vertically on the rotor shaft and key can cause bob bearing distortion.
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Maintenance Schedule
MAINTENANCE SCHEDULE
INSTRUMENT NAME
COMPONENT
Rotor
Bob
Bob Shaft Bearing
Bob Shaft
Torsion Spring
Timing Belt
Instrument Calibration

EACH TEST
Clean
Clean

MONTHLY

3 MONTHS

6 MONTHS

ANNUAL

Inspect **
Inspect **
Inspect **
Inspect **
Check calibration

This maintenance schedule applies to normal usage of two tests per day. Detailed procedures for these operations are
contained in your manual.
⚫ Per API Specifications
* Where Applicable
** Replace as needed

SECTION 4 – TROUBLESHOOTING GUIDE

Section 4 – Troubleshooting Guide
Problem

Solution

Unsteady Dial Reading

• The bob shaft bearings may be dirty. Replace the
bearings.
• The rotor and bob may not be concentric.
Remove both the rotor and bob, clean all
mounting surfaces, replace the rotor and bob.
• The spring may be worn, replace.
• The bob shaft may be bent. Replace the shaft
assembly.

Belt Makes Noises

• The drive belt is too tight, adjust the belt
tensioner.

Motor Operates At Wrong Speeds.

• The wiring from the RPM selector switch
may be damaged. Repair the wiring.

Instrument Does Not Operate When
Power Switch Is ON.

• Inhibit switch in Inhibit ON position. Change
switch position and try again.
• Check fuses and replace if necessary.
• The power switch may be defective, replace the
switch and connector assembly if necessary.
• The motor controller may be defective. Replace
if necessary.
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Section 5 - Replacement Parts
Part Number
35-0101
35-0111
35-0112
35-0118
35-0125
35-0131
35-0132
35-0133
35-0134
35-0136
3530-CUP
35-0191
35-0228
35-0285
3506-F1
3530-1011
3530-1031
3530-1032
3530-1062
3530-1100
3530-1105
3530-1106
3530-1108
3530-1109
3530-1111
3530-1112
3530-1113
3530-1114
C07560
C09848
C09906
C10029
C10075
C10533
C10534
C10557
C10582
C11037
C13673
C15723
P-0066
P-1233
P-2441

Description
Stage
Spacer
Nut
Bob (Type B1) Assembly
Shield
Sleeve, Zero Adjust
Guard, Splash
Idler Arm
Spacer, Short Shaft
Timing Belt Pulley, Modified
Sample Cup
Rotor
Shaft, Rotor
Label, Speed Control
Torsion Spring Assembly (F1)
Bob Shaft Assembly
Speed Selection Circuitry
Wiring Kit
Programmed Stepper Controller And Encoder Module
Cover, Base
Tube Support
Tube Support, Modified
Gear Box
Gear Box Cover
Timing Belt Pulley with Set Screw
Encoder Bracket
Motor Controller Bracket
Base
Standoff
LED
Cap, Torsion Spring
Stepper Motor
Collar, Clamp-on Shaft .5 x 1.13 x .40
Encoder Module
Encoder Disk
Timing Belt
Allen Nut, 7/16-20
Fuse, 2.000A, 250V, 5X20 Time Delay
Power Supply, 110/220VAC
Power Entry Module, 250V, 2A, 5x20
O-Ring (Bumper)
Foot, Rubber
Power Cord,18AWG,1250W/10A
-3530-REPL_PARTS REV B
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SECTION 5 – REPLACEMENT PARTS

Part Number

Description

P-2931
P-2932
P-2933
P-2945
P-2948
P-3002

Bearing, Main
Bearing, Bob Shaft
Bearing, Idler
Plug, Hole
Knob, Selector
Knob, Locking

OPTIONAL ITEMS:
35-0246
35-0261
35-0262
35-0263
35-0264

R2 Rotor
B2 Bob Assembly
B3 Bob Assembly
R3 Rotor Nut
R3 Rotor

To ensure correct part replacement, always specify Model and Serial Number of instrument when
ordering or corresponding.

-3530-REPL_PARTS REV B
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Section 6 - Drawings and Schematics
Drawing Number
3530-1000
3530-1030

Description
Assembly, Model 3530
Schematic, Model 3530

-3530-DWGS REV A
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PART NUMBER
DESCRIPTION
QTY
UoM
3530-1114
BASE,MODIFIED
1
C18608
POWER SUPPLY,85-264VAC,48V,2.3A,ENCLOSED
1
3530-1100
COVER,BASE
1
3530-1101
COVER,BASE,REAR
1
C11614
MODULE,PWR ENTRY,250V,4A,FLTR
1
G
P-1233
FOOT,RUBBER,0.9687OD
4
3530-1105
TUBE SUPPORT
1
3530-1106
TUBE SUPPORT, MODIFIED
1
3530-1108
GEAR,BOX,3530
1
P-2931
BRG,BALL,RAD,0.625X1.375X0.344
2
35-0228
SHAFT,ROTOR
1
P-2932
BRG,BALL,RAD,0.187X0.500X0.150
2
35-0125
SHIELD
1
35-0132
SPLASH GUARD
1
35-0191
ROTOR-R1
1
35-0245
NUT, COUPLING, ROTOR
1
3530-1109
COVER,GEAR BOX,3530
1
3530-1040
PCA,ASSEMBLY,3530 SPEED SELECT,MFORCE
1
35-0153
LIGHT PIPE
1
F
35-0317
RETAINER,LIGHT PIPE
1
P-2948
KNOB,SKIRTED,W/PTR,1/4"SHAFT
1
35-0101
STAGE
1
3506-CUP
SAMPLE CUP
1
3530-1115
LABEL,FRONT,3530
1
P-0407
SWITCH,TGLE,PNL,DPST,ON/XX/OFF
1
3530-1119
LABEL,INHIBIT SWITCH
1
3530-1113
CONTROLLER BRACKET
1
3530-1062
PROGRAMMED STEPPER CONTROLLER
1
C11613
BOOT,REAR COVER,PLASTIC
1
3530-1033
ASSY,CABLE,CONTROLLER,MODEL 3530
1
C11037
FUSE,2.000A,250V,5X20,TIMEDELAY
2
3530-1034
ASSY,CABLE,MOTOR,MODEL 3530
1
3530-1035
ASSY,CABLE,COMMS,MODEL 3530
1
E
3530-1112
ENCODER BRACKET MODEL 3530
1
C10533
OPTICAL ENCODER, 2048 CPR
1
C10534
ENCODER DISK,2"OD,0.75" HUB
1
35-0136
PULLEY,MODIFICATION
1
35-0300
BUSHING
1
35-0115
CLAMP - SPRING
2
35-0131
SLEEVE
1
C10029
MOTOR,STEP,NEMA23
1
3530-1011
BOB SHAFT ASSEMBLY
1
C09906
CAP,.980"ID,1"H INSIDE,VINYL
1
3530-1111
PULLEY WITH ADDED SET SCREW
1
C10557
BELT,TIME,.3125W,155T,5/16P
1
35-0133
IDLER ARM
1
P-2933
BRG,BALL,RAD,0.250X0.625X0.562
1
D
H-25-017
SCREW,BHMS,SS,1/4-20X0.750,PHI
1
H-10-011
SCREW,BHMS,SS,10-24X0.375,PHIL
1
P-2929
LENS, PCX, 16MM X 40MM F.L.
1
35-0166
TORSION SPRING ASSEMBLY,F1
1
35-0140
POINTER
1
P-2945
PLUG,SS,1/4,HOLE,NP
1
C10116
RING,RET,INT,1.375,BASIC
2
C09992
WSHR,WAVE SPRG,.648X.866X.012
1
P-3595
RING,RET,EXT,0.625,INVERTED
1
35-0118
BOB (30844)
1
P-0065
ORING,BUNA,AS112-70
2
P-3014
NUT,HEX,SS,7/16-20,JAM
2
C11015
COLLAR,SHAFT,.5ID 1.25OD,SS
1
35-0112
NUT,LOCKING STAGE
1
C
35-0111
SPACER
1
P-3002
KNOB,CLAMP,SEMI-GLOSS,.250-20
1
C10582
ALLEN NUT,7/16-20,ALLOY STEEL
2
P-3006
RING,SNAP
1
P-3181
RIVET,POP,AL,0.187X0.250L
4
H-6013
SCREW,BHMS,SS,6-32X0.312,PHIL
6
H-6001
WSHR,LOCK,SS,#6
6
H-4104
SCREW,BHMS,SS,4-40X0.187,PHIL
4
H-4001
WSHR,LOCK,SS,#4
8
H-6019
SCREW,BHMS,SS,6-32X0.500,PHIL
4
H-4108
SCREW,PHMS,SS,4-40X0.375,PHIL
2
H-3010
SCREW,RHMS,3-48X0.50,18-8,PHIL
2
H-10-124
SCREW,SHCS,SS,10-32X0.375,ALN
4
B
C12096
SCREW,THMS,SS,6-32X0.875,PHIL
4
C09845
WSHR,NYLON,0.140X0.313X0.062THK
4
35-0285
LABEL,TOP,16 SPEED,3500LS
1
C12468
CONV,COMM,RS232-RS422
1
C09285
STDF,HEX,ZN,0.18X0.31,4-40,M/F
2
H-4101
NUT,HEX,SS,4-40
2
C10722
CONN,AMP,5-PIN LOCKING
1
C10723
CONN,PIN,AMP,24 AWG
4
C11615
FUSE DRAWER,2-POLE,FINGERGRIP
1
70607-80
JUMPER,BARRIER,2 POSITION
1
C15936
CAP PLUG
1
35-0174
LABEL,BASE COVER
1
3530-1104
LABEL,BACK COVER,200-240 VAC
1
Q5-C-1043
SCREW,PHMS,SS,4-40X0.250,PHIL
2
A
3530-1060
PROC,ASSEMBLY,3530
REF
3530-1030
DIAGRAM,WIRING,3530
REF
P-2950
BOOT,SWITCH
1
BREAK EDGES, DEBURR DRAWN: DLR 8/4/2020
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MFG: -07-24-20
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PN:
3530-1000
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Please Send Us Your Comments on This Manual
Model Number ____________________________ Serial Number __________________________
Printing Date of this manual (from the Title Page) ______________
Please circle a response for each of the following statements. Use:
(1)= Strongly agree (2) =Agree (3) =Neutral, no opinion (4) =Disagree (5) =Strongly disagree
a) The manual is well organized.
1
2
3
4
5
b) I can find the information I want.
1
2
3
4
5
c) The information in the manual is accurate.
1
2
3
4
5
d) I can easily understand the instructions. 1
2
3
4
5
e) The manual contains enough examples. 1
2
3
4
5
f) The examples are appropriate and helpful.
1
2
3
4
5
g) The manual layout is attractive and useful.
1
2
3
4
5
h) The figures are clear and helpful.
1
2
3
4
5
i) The sections I refer to most often are ________________________________________________
______________________________________________________________________________
Other comments _________________________________________________________________
______________________________________________________________________________
Contact us at our website: www.chandlereng.com
Email: chandler@chandlereng.com

Please add me to your mailing listfor Product Updates and New Product Releases, Information,
Technical Articles, and General Announcements of interest to users of this instrument.
Name ______________________________________________________________
Company ____________________________________________________________
Address _____________________________________________________________
Email address _________________________________________________________
My instrument is Chandler Model ________________________
Serial Number __________________________
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Warranty

CHANDLER
ENGINEERING
All products of Chandler Engineering are warranted for a period of one year from date of shipment to be free from
defective workmanship and material. Providing written notice is made and authorization by us is given, any of our
products claimed to be defective may be returned freight prepaid to our factory. If found to be defective and after
examination by us, our obligation will be limited to repairing or replacing the product, at our option, free of charge,
F.O.B. our factory.

COMMERCIAL INSTRUMENTATION
MANUFACTURED BY OTHERS
Commercial instrumentation manufactured by others is covered by separate manufacturer warranty, generally for
one year. Contact Chandler Engineering for instructions on obtaining service directly from the manufacturer.
Our warranty does not cover damage or failure caused by abuse, misuse, abnormal usage, faulty installation, improper maintenance, or any repairs other than those provided by authorized Chandler Engineering personnel.
This warranty is in lieu of all other warranties, expressed or implied, and of all obligations or liabilities on its part for
damages including but not limited to consequential damages, following the use or misuse of instruments manufactured by Chandler Engineering Company L.L.C.

NO WARRANTY OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE SHALL APPLY.
Our total liability on any claim shall not exceed the price allocable to the product or service or part thereof that
gives rise to the claim.

Houston Sales and Services
4903 W. Sam Houston Parkway, N., Suite A-400, Houston, TX 77041
Fax: +1 713-849-1924
Tel: +1 713-466-4900

2001 North Indianwood Avenue, Broken Arrow, OK 74012
Fax: +1 918-459-0165
Tel: +1 918-250-7200
e-mail: chandler.sales@ametek.com
Printed in the U.S.A.

www.chandlereng.com
© 2008, by AMETEK, Inc. All rights reserved.
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